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     Vero Beach Computer Group 

General Meeting November 8, 2006 
7:00 PM at the Vero Beach Main Library 

Media Room 

 

Wayne Kleinstiver, past president of the 
Vero Beach Computer Group, will 
be the speaker at the Group's No-
vember 8 General Member meet-
ing at the Vero Beach Main Li-
brary Media  Room.  
 
Wayne created the presentation 
for the Sunday Nov. 5 (1-4 PM) 
Vero Beach Opera Guild's Opera 
Studies event at the Vero Beach 
Art Museum on the Russian op-
era, Boris Godunov. He will dis-
cuss at our Wednesday Nov. 8 

VBCG meeting how he created this presentation, which 
includes slides, music and video - - of special interest 
will be his use of the internet to research and gather 
more than half the materials for the presentation.  
 
Wayne's presentations are always well prepared and 
informative. Wayne uses both the PC (Windows) and 
MAC, and this presentation will be a interest to both the 
Windows and MAC users.  



Apple Corner 
 

Dashboard Widgets—Amazing widgets for your  
Mac OS X Dashboard 

iStat nano 
Our best ever stats widget, and it’s free!  
 
View detailed information on CPU, memory, hard drives, IP 
and external IP, bandwidth, CPU temperature, battery, uptime 
and the top four processes.  
 
iStat nano features the lowest CPU usage of any stats widget 
we’ve seen (compare it if you don’t believe us, I’m sure you’ll 
be pleasantly surprised!). 

If you would like you very own iStat nano widget, visit www.apple.com for a free download.  You can even find a “chia 
pet” widget for the Dashboard! 

Mac OS X Tip of the Week 

From EPS to PDF in No Time Flat 

This trick is pretty much just for graphic designers who work with EPS images from applications like Adobe illustrator, 
Coreldraw for Mac, Freehand, and Photoshop. If you want to convert your EPS image instantly into a PDF (ideal for 
emailing), just drag it onto Apple’s Preview application icon in your dock (or in your Applications folder) and Mac OS X 
automatically converts your Postscript file to a PDF on the fly. When you choose save from the File menu, it will save as 
a PDF. 

Emailing Web Pages 

If you run across a web page you want to share with a friend, don’t send her a link to it — send her the page itself. Just 
press Command-I and a dialog will appear, asking for the email address of the person you want to send this web page 
to. Just enter her email address, along with your text message, and click send, and it will send the contents of that page 
(complete with graphics, formatting, links, etc.) to your friend. She’ll be able to see that page right within her email 
application. 

Apple's Time Machine: Forward into the past? 

The backup app in Mac OS X 10.5 represents 'a paradigm shift' 

By Ryan Faas    

October 05, 2006 (Computerworld) -- One of the most talked about features in Apple Computer Inc.'s upcoming 
operating system, Mac OS X 10.5, also known as Leopard, is the built-in backup tool called Time Machine. For Mac 
users, Time Machine is big news: It marks the first time Apple has bundled any sort of backup solution with its operating 

system. (While it's true that Apple's .Mac service includes a 
basic consumer backup tool, the service is available only to 
subscribers of .Mac -- at a cost of $99 per year.)  

 

Being a Mac OS X backup tool isn't the main reason Time 
Machine is important. There have been any number of free, 
shareware and commercial backup tools for quite some 
time. But Time Machine is a step ahead of competitors 
because it's designed by Apple as a backup tool for the 
average computer user, meaning that it is very simple to 
use, with virtually no management or oversight needed. 
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    MEETINGS AND SIGS 

All meetings and SIGs are held in the Indian River County Main Library  
located at 1600 21 Street, Vero Beach, Florida 

Macs Eleanor Ryan & Joe Piazza History Room 

MS Excel Wayne Kleinstiver History Room 

Introduction to PCs Jean Grider History Room 

Cameras, Scanners & Printers Frank Lombard History Room 
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 News from the Help Desk                                                     of Smart  Computing magazine 

 
How do I compose an email message so that the photo or image shows up in 
the body of a message instead of as an attachment? 
 
When an image appears within the body of an email message, it is called an 
embedded image.  In order to embed an image in a message, you will need 
to alter the settings of your email program so that the messages you com-
pose are in HTML (Hypertext Markup Language) format. 
 
For example, in Microsoft Outlook Express, click the Tools menu and select 
Options.  In the resulting Options dialog box, click the Send tab.  Under Mail 
Sending Format, make sure the HTML radio button is selected.  Click the 
HTML Settings button and then click OK. Click OK again. 
 
To ensure that your graphics files are embedded rather than attached, when 
you compose your message, click the Format menu and make sure that the 
Rich Text (HTML) option is selected.  If it is not selected, click to activate the 
Rich Text (HTML) setting. 
 
Finally, to embed the file in your document, make sure your cursor is in the 
position where you want the picture to appear.  Click the Insert menu and 
select Picture. Navigate to the image file’s location on your hard drive and  
double click it.  Click OK to embed the image in your email message 
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Can a USB Key Save Your Life? 
USB-based key drives are a valuable resource for storing information that we can easily move from loca-
tion to location.  Perhaps it was only a matter of time before a company developed a key drive designed 
to store information that could save lives. 
 
The ICER-2-Go (ICER stands for In Case of Emergency Record) system includes software that let’s users 
fill out an emergency record on a USB drive that is attached to a keychain or worn around users’ necks.  
The ICER-2-Go software ($99; www.icer-2-go.com) allows input of two types of information: medical and 
personal.  The medical information is not encrypted or pass-word-protected, allowing easy access by 
emergency responders.  This information can include name, address, picture (including identification 
marks), blood type, emergency contact information, medication history, allergies, primary physicians, and 
special medical needs. 
 
The software also allows input of encrypted, password-protected information such as employer informa-
tion, financial records; insurance coverage ;school records, pet records; photographs; medical history; 
copies of wills, donor registration, and property deeds; and other information.  Both the personal and 
medical information can be stored on ICER-2-Go’s 512 MB drive (sold separately for $49.95).  Although 
that’s a hefty price for a 512MB drive, the company says the drive’s logo will alert medical responders to 
the information contained on the drive. 
 

Smart  Computing  Magazine, November  2006 

Important Notice ! 

The Boys & Girls Club of Indian River County are holding a fund-raising raffle.  
The prize is a luxury townhouse or $200,000 cash!.  For more information 
please see the link to the ad for the raffle on the opening page of the VBCG 
website.  Look for the link that says "Boys & Girls Club Raffle".  The Raffle 
drawing will be held December 15, 2006. 

The VBCG is not affiliated with the Boys & Girls Club of Indian River County or any sponsors of the 
raffle. 

http://www.icer-2-go.com
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Tips & Tricks for Windows 
 
Zero Assumption Digital Image Recovery v8.0 [2.2M] W98/2k/XP FREE, Lockergnome Windows Digest, 3-29-03 
  
http://www.z-a-recovery.com/digital-image-recovery.htm 
  
{Image data recovery} A friend and I went to a conference where she took many pictures with her digital camera. When we returned 
home, horror of horrors, she somehow lost her pictures that were stored on her media card. Another friend came to the rescue with a 
program that dug up the lost photo-souls. Zero Assumption serves the same purpose and works with any media type (CompactFlash, 
SmartMedia, and Memory Stick, for example) accessible through Windows. How can photos be recovered when they've been deleted or 
pulled a disappearing act? It's possible because when "deleting," cameras typically delete references to photos - not the photos themselves 
- meaning the photos are still in memory, but not accessible through the usual methods. Non-standard methods like this program can 
recover images as long as no new data was written over them. 
    
NotePad XP v2.0 [1.8M] W9x/2k/XP FREE, Lockergnome Windows Digest, 3-29-03 
  
http://www.acsoftware.org 
  
The only use I ever found for Microsoft Notepad was to create HTML documents and open up files with quirky formats, but now with 
NotePad XP you get tons of extra features for zero - yes ZERO! - dollars. Some of the features include word count, customizable 
date/time formatting, bullets, mail merge, dockable toolbars, no size limit on documents (unlike regular Notepad), align text, and an XP 
graphical interface that's clear-cut and easy on the eyes. You can even have multiple documents open within the program.  And probably 
the best feature ever (that just sweetens the deal) is the search and replace feature. (THANK YOU!) I've always used Microsoft's Notepad 
for creating Lockergnome reviews, but not anymore. And the best part of it all: this program opens up in approximately one second. 
  
IMage CATalog v4.0.6 [1.3M] W9x/2k/XP FREE, Lockergnome Windows Digest, 3-29-03 
  
http://www.snapfiles.com/get/imcat.html 
  
IMCAT is a thumbnailing utility that is capable of batch processing directories and converting all found images into thumbnails. It can 
identify and delete orphan thumbnails, guess image titles from file names, and more. Advanced mode offers many professional-level 
features, like file name modification, unlimited banner code insertion, extensive Meta tag support, advanced navigational menu control, as 
well as creation of a separate page for each image feature, driven by templates that can be edited. The program offers both an Express 
and an Advanced mode; the advanced mode offers most of the features mentioned, while the Express mode performs simple batch 
conversions of image directories. Both modes are available in this free version; however, a Pro version is also available, which adds 
directory batch in Advanced mode. 
  
VacuPad v1.5 [198k] W2k/XP FREE, Lockergnome Windows Digest, 3-29-03 
  
http://www.filetransit.com/view.php?id=14811 
  
VacuPad is a dialog-based application for cleaning traces of a user's footprints and temporary system files from Windows. It doesn't do 
windows, but it does clean "Find files" history, "Find computers" history, URL history, network history, and telnet history; auto-complete 
forms, auto-complete passwords; most recently used "Run" commands; Recent Documents; temp directory; Recycle Bin; Internet 
Explorer's cache; cookies, and favorites; RAS autodial; last logon user; and Google bar history. It cleans everything in a single click, so use 
it with caution - just like any other cleaner program. 
 
CDDA Ripper v0.65 [1.1M] W98/2k/XP FREE, Lockergnome Windows Digest, 3-29-03 
  
http://www.milix.net/cddarip/index.html 
  
Featuring this program is not a hint that you should steal audio. Rather, use CDDA Ripper if you want to extract contents from your CD 
and encode them to PCM, WAV, MP3, WMA, or OGG Vorbis files for your PC. True, there are plenty of such programs from which to 
choose, and I don't recommend one over the other, especially since I'm no audio pro. CDDA Ripper offers CDDB and ID3 tag support, 

templates for track name generation, a built-in CD player, and the option to 
put an album into its own folder. The steps are easy enough. Start the 
program, assign a folder, insert the audio CD, press F5 to refresh, select the 
tracks you want, and press Ctrl + R. 
 
 

Vero Beach Computer Group is a self-help group that provides help to members who want to 
improve their knowledge to computers and accessories.  Our motive is to share our experiences 
and give members a chance to learn and help each other.  Every effort is made to share accurate 
information, however no representations or warranties either expressed or implied are made as 

to its accuracy. 

http://www.z-a-recovery.com/digital-image-recovery.htm
http://www.acsoftware.org
http://www.snapfiles.com/get/imcat.html
http://www.filetransit.com/view.php?id=14811
http://www.milix.net/cddarip/index.html



